
Pulse Quality 
Program Testing 

Manual 
 

 

 

 

 

 

 

 

 

 

 

 

 

FOOD CROP QUALITY PROGRAM 

SASKATCHEWAN FOOD INDUSTRY DEVELOPMENT CENTRE INC. 



 
2335 SCHUYLER STREET, SASKATOON, SASKATCHEWAN, S7M 5V1, TEI: (306) 933-7555, FAX: (306) 933-7208 

 

ACKNOWLEDGEMENTS 

We would like to express our sincere thanks to the Saskatchewan Pulse Growers for financially 

supporting this program. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Contact information: 

 

Lindsay (Yingxin) Wang, Ph.D. 

 

Manager, Food Crop Quality 

Saskatchewan Food Industry Development Centre Inc. (Food Centre) 

2335 Schuyler Street, Saskatoon, SK, S7M 5V1, Canada  

Direct: (306) 964-1819  

E-mail: lwang@foodcentre.sk.ca  

 

Mehmet Tulbek, Ph.D. 

 

President 

Saskatchewan Food Industry Development Centre Inc. (Food Centre) 

2335 Schuyler Street, Saskatoon, SK, S7M 5V1, Canada  

Direct: (306) 933-7175  

Fax: (306) 933-7208 

Main office: (306) 933-7555 

E-mail: mtulbek@foodcentre.sk.ca  

 

  



 
2335 SCHUYLER STREET, SASKATOON, SASKATCHEWAN, S7M 5V1, TEI: (306) 933-7555, FAX: (306) 933-7208 

 

Appendix A: Pulse Quality Testing Manual 

 

 Table of Contents 
 

1. INTRODUCTION ............................................................................................................. - 1 - 

2. TESTING PROTOCOLS.................................................................................................. - 2 - 

A. Sample labelling ................................................................................................................ - 2 - 

B. 1000 Seed weight ............................................................................................................... - 3 - 

C. Seed size distribution ........................................................................................................ - 5 - 

D. Amount of foreign matter ................................................................................................. - 7 - 

E. Amount of damage and splits ............................................................................................ - 8 - 

F. Seed hardness ................................................................................................................. - 13 - 

G. Appearance of whole seed ............................................................................................... - 15 - 

H. Milling of flour ................................................................................................................ - 18 - 

I. Colour of pulse flour ....................................................................................................... - 23 - 

J. Hausner ratio .................................................................................................................. - 26 - 

K. Particle size ..................................................................................................................... - 28 - 

L. Ash content ..................................................................................................................... - 30 - 

M. Moisture content ............................................................................................................. - 32 - 

N. Protein content ................................................................................................................ - 33 - 

3. INSTRUMENT MAINTENANCE ................................................................................. - 39 - 

A. Balance ........................................................................................................................... - 39 - 

B. Muffle furnace ................................................................................................................ - 40 - 

C. Colourimeter ................................................................................................................... - 41 - 

D. Protein analyzer .............................................................................................................. - 42 - 

 

  



 
2335 SCHUYLER STREET, SASKATOON, SASKATCHEWAN, S7M 5V1, TEI: (306) 933-7555, FAX: (306) 933-7208 

 

 



 
2335 SCHUYLER STREET, SASKATOON, SASKATCHEWAN, S7M 5V1, TEI: (306) 933-7555, FAX: (306) 933-7208 

 

- 1 - 
 

1. INTRODUCTION 
 

The Pulse Quality Program launched in spring 2022 with a partnership between Saskatchewan 

Pulse Growers and the Saskatchewan Food Industry Development Centre, Inc (Food Centre). The 

mission of the program is to add in best management practices for pulses grown in Western Canada 

and to help the development of pulse-based ingredients/products in the food industry. The program 

will develop a comprehensive database of composition, functionality, and nutrition for pulses and 

related standardized methodology for high throughput screening purposes. 

Pulses are being recognized as excellent food sources to provide high proteins, dietary fibers, 

and a sufficient amount of minerals and thereby have gained stupendous interests in the supply 

chain (Tosh & Yada, 2010)1. In the past decade, pulse-related products have increased by over five 

times, and pulse flours have been mainly applied in the extruded (pasta, noodles, snacks), baked 

(bread, cakes, cookies, gluten-free products), and meat-related products in the food industry. 

Canada is one of the largest producers of pulses and the global leader in pulse exports. The 

production of national peas and lentils in 2020 was 4.6 and 2.9 million tonnes, respectively, where 

Saskatchewan has contributed 84-96% and 48-63% of lentil and pea production over the past 

decade (Canadian Grain Commission, 2011-2021).  

A genotype by environment evaluation (GxE) on quality parameters of pulses will give 

information to growers, breeders, pulse processors, and end users. For instance, information can 

help growers and breeders monitor their crops, change their decision making on cultivation of 

pulse crops the next year, and lead to new breeding program. Knowledge will help pulse processors 

on ingredient selection and product development. Data will also help SK Food Centre develop 

value proposals for the pulse processing industry 

This program will implement a GxE evaluation on pulse quality. In the first phase of the 

program, pulses including peas, lentils, chickpeas, faba beans, and dry beans with up to 3000 

samples annually from multiple cultivars and locations in 2021-2024 will be analyzed. The main 

focus of parameters includes seed quality (i.e. 1000 seed weight, amount of damage and foreign 

matter, seed size and hardness, and appearance), nutritional composition (i.e. ash, moisture, and 

protein contents), and physical properties (i.e. colour, particle size, and Hausner ratio). This testing 

manual describes the procedure to evaluate each parameter above.  

                                                           
1 Tosh, S. M., & Yada, S. (2010). Dietary fibres in pulse seeds and fractions: Characterization, 

functional attributes, and applications. Food research international, 43(2), 450-460. 
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2. TESTING PROTOCOLS 
 

A. Sample labelling 

 

Sample labelling is critical when handling a significant number of samples. In this project, samples 

from the same type, year, and location are determined at a time for all the experiments. Thus, 

samples to be measured at the same time is labelled according to the plot number. 

Results are recorded in the template Excel sheets, which can be found in the file of “Food 

Crop Quality Program” under Group Storage “G” drive.  
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B. 1000 Seed weight 

 

Seed weight is an important parameter to indicate seed size and yield production. Knowledge of 

this characteristic is fundamental to seeding management and pulse crop establishment. This 

method determines the weight of 1000 seeds. 

 

Apparatus: 

1. Top loading balance 

2. Counting trays 

 

 

 

Procedure: 

1. Place one seed to each mold of the counting trays until all the molds are filled with seeds. 

a. 300/ pan seed counting tray: Lentil (extra small, small, French green). 

b. 100/ pan seed counting tray: Lentil (medium, large); Pea; Chickpea. 

c. Gummy bear seed counting tray: Faba bean; Dry bean. 

2. Repeat step 1 to achieve 300 seeds. Weigh 300 seeds and record. Broken and damaged 

seeds are excluded. 

3. Duplicated measurements are preformed. The 1000 seed weight is calculated and reported 

using the equation below. 

 Large lentils 

 Peas 

 Chickpeas 

 

 Dry beans 

 Extra small 

to medium 

lentils 

 

 as 

 Faba beans 

 Dry beans 
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Calculation: 

1000 seed weight (g) = 
300 seed weight (g)

3
× 10 

  

 Small lentils  Green peas  Chickpeas 
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C. Seed size distribution 
 

This method determines the size distribution of the pulse seeds. Seed size is important in seeding 

management and pulse crop establishment. 

 

Apparatus: 

1. Metal hand sieves 

a. #28R: 11.11 mm 

b. #26R: 10.32 mm 

c. #24R: 9.52 mm 

d. #22R: 8.73 mm 

e. #20R: 7.94 mm 

f. #18R: 7.14 mm 

g. #16R: 6.35 mm 

h. #14R: 5.56 mm 

i. #12R: 4.76 mm 

j. #10R: 3.97 mm 

 

 

Procedure: 

1. Weigh 250 ± 2 g seeds and record. Working sample size and sieve sizes are chosen 

according to the recommendation of Official Grain Grading Guide. 

2. Pile the sieves from the largest opening to the smallest opening. 

3. Pour the sample seeds from the top sieve, and shake until all the seeds pass through the 

openings of each sieve. 

4. Take the top sieve to a second container. Shake again and make sure the smaller seeds pass 

through the sieve. Pour the retained seeds of each sieve into a separate container and pick 

out the foreign matter. 

5. For picking the foreign matter, collect all seeds into a deli cup and then pour a very small 

amount at a time into a larger container. Pick out the foreign into a separate deli cup and 

then swipe the lentils to the side in the container. Repeat until all lentils are cleaned of 

foreign.  

6. Weight the retained seeds. 

7. Repeat steps 4 to 6 for the next sieve.  

8. Collect all the foreign matter at the end and record the total weight. 

9. The above measurements are to be duplicated for the same cultivar and same location. 

 

Sieve selection: 

Peas: green, maple, and yellow. 

 Green: normally size from #20R (7.94 mm) to below #14R (5.56 mm) 

 Yellow: normally size from #20R (7.94 mm) to below #14R (5.56 mm) 



 
2335 SCHUYLER STREET, SASKATOON, SASKATCHEWAN, S7M 5V1, TEI: (306) 933-7555, FAX: (306) 933-7208 

 

- 6 - 
 

 Maple: normally size from #20R (7.94 mm) to below #14R (5.56 mm) 

 If over 10 g of peas remain at #20R (7.94 mm) sieve, please sieve through using the #22R 

(8.73 mm) sieve as well. 

 Anything passing through #14R (5.56 mm) is considered smaller. 

 

Lentils: Green (French green, small, large), Red (extra small, small, medium, large), and 

Spanish brown. 

 Extra-small: normally size from #14R (5.56 mm) to below #10R (3.97 mm) 

 Small: normally size from #14R (5.56 mm) to below #10R (3.97 mm) 

 Medium: normally size from #16R (6.35 mm) to below #10R (3.97 mm) 

 Large: normally size from #18R (7.14 mm) to below #10R (3.97 mm) 

 If over 10 g of lentils remain at the top sieve, please try it with a larger sieve. 

 Anything passing through #10R (3.97 mm) is considered smaller. 

 

Chickpeas: black desi, desi, and kabuli.  

 Black desi: black color, normally size from #20R (7.94 mm) to below #14R (5.56 mm) 

 Desi: brown color, normally size from #22R (8.73 mm) to below #14R (5.56 mm) 

 Kabuli: yellow color, normally size from #24R (9.52 mm) to below #14R (5.56 mm) 

 If over 10 g of seeds remain at the top sieve, please try it with a larger sieve. 

 Anything passing through #14R (5.56 mm) is considered smaller. 

 

Faba beans: Tannin (coloured flower) and Zero tannin (white flower) 

 Tannin: normally size from #28R (11.11 mm) to below #14R (5.56 mm) 

 Zero tannin: normally size from #26R (10.32 mm) to below #14R (5.56 mm) 

 If over 10 g of seeds remain at the top sieve, please try it with a larger sieve. 

 Anything passing through #14R (5.56 mm) is considered smaller. 

 

Beans: Black, FDJ, navy, pinto and yellow 

 Navy: normally size from #14R (5.56 mm) to below #10R (3.97 mm) 

 Black: normally size from #16R (6.35 mm) to below #10R (3.97 mm) 

 FDJ, pinto and yellow: normally size from #22R (8.73 mm) to below #10R (3.97 mm) 

 If over 10 g of beans remain at the top sieve, please try it with a larger sieve. 

 Anything passing through #10R (3.97 mm) is considered smaller. 

 

 

Calculation: 

For instance, for seeds do not pass through #24 (9.52 mm): 

>9.52 mm (%) = 
𝑤𝑒𝑖𝑔ℎ𝑡 𝑜𝑓 𝑠𝑒𝑒𝑑 𝑐𝑜𝑙𝑙𝑒𝑐𝑡𝑒𝑑 𝑎𝑡 #24 (𝑔)

𝑠𝑢𝑚 𝑜𝑓 𝑠𝑒𝑒𝑑 𝑤𝑒𝑖𝑔ℎ𝑡 (𝑔)
× 100% 
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D. Amount of foreign matter 

 

The present of foreign matter reduce pulse value. Information of this characteristic will help 

determine the pro-harvest factors and harvest method for pulse harvesting. This protocol 

determines the purity of the seeds. 

 

Apparatus: 

1. Top loading balance 

 

Procedure: 

1. Foreign matter is selected out during the measurements of sizing distribution. 

2. Pick out the foreign matter remained at each metal hand sieve. 

3. Weigh out the total foreign matter. Duplicated measurements are preformed, and the 

average is reported. 

 

Calculation: 

Foreign matter (%) = 
𝑤𝑒𝑖𝑔ℎ𝑡 𝑜𝑓 𝑓𝑜𝑟𝑒𝑖𝑔𝑛 𝑚𝑎𝑡𝑡𝑒𝑟 (𝑔)

𝑠𝑢𝑚 𝑜𝑓 𝑠𝑒𝑒𝑑 𝑤𝑒𝑖𝑔ℎ𝑡 𝑎𝑛𝑑 𝑓𝑜𝑟𝑒𝑖𝑔𝑛 𝑚𝑎𝑡𝑡𝑒𝑟 (𝑔)
× 100% 

 

Note: 

1. Foreign matter includes ergot, excreta, insect parts, stones, other type or cultivar of 

seeds, and all other extraneous materials. 

2. Pea: 

a. When sizing green peas, please differentiate between bleached green pea (appears as 

yellow) and yellow pea. When sizing yellow peas, please differentiate between 

immature yellow pea (appears as green) and green pea. 

3. Lentil: 

a. A lentil is prone to contain other types of lentils in the plot due to contamination from 

harvesting. 

b. Key features to differentiate: speckles, seed coat colour, and size. 

c. A similar colour seed coat/hull makes different types of lentils difficult to identify 

from each other. Please verify with supervisor when in doubt. 

d. If you are unsure whether a lentil is foreign, the lentil can be crushed with mortar and 

pestle or snipped with scissors a small amount of the outer seed coat to see the 

cotyledon colour. 

4. Chickpea, faba bean, and dry bean: 

a. Key features to differentiate: seed coat color and size.   
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E. Amount of damage and splits 

 

The present of damaged seeds reduce pulse value. Information of this characteristic will help 

determine the pro-harvest factors and harvest method for pulse harvesting. This protocol 

determines damage of the seeds. 

 

Apparatus: 

1. Top loading balance 

 

Procedure: 

1. Weigh out the recommended seed weight (see Table 1e) and record the weight. Working 

sample size is chosen according to the recommendation of Official Grain Grading Guide2. 

2. Select out the damaged seeds and splits by hands, and weigh them separately. 

 

Table 1e. Working sample size of each seed type for damage and split determination. 

Seed type Working sample size (g) 

Lentil 50 

Pea 100 

Chickpea 100 

Faba bean 100 

Dry bean 100 

 

Calculation: 

Total damage (%) = 
𝑤𝑒𝑖𝑔ℎ𝑡 𝑜𝑓 𝑑𝑎𝑚𝑎𝑔𝑒𝑑 𝑠𝑒𝑒𝑑 (𝑔)

𝑤𝑒𝑖𝑔ℎ𝑡 𝑜𝑓 𝑠𝑒𝑒𝑑 (𝑔)
× 100% 

Split or mechanical damage (%) = 
𝑤𝑒𝑖𝑔ℎ𝑡 𝑜𝑓 𝑠𝑝𝑙𝑖𝑡𝑠 (𝑔)

𝑤𝑒𝑖𝑔ℎ𝑡 𝑜𝑓 𝑠𝑒𝑒𝑑 (𝑔)
× 100% 

Other damage (%) = 
𝑎𝑙𝑙 𝑡𝑦𝑝𝑒𝑠 𝑜𝑓 𝑑𝑎𝑚𝑎𝑔𝑒 𝑒𝑥𝑐𝑙𝑢𝑑𝑖𝑛𝑔 𝑚𝑒𝑐ℎ𝑎𝑛𝑖𝑐𝑎𝑙 𝑑𝑎𝑚𝑎𝑔𝑒 (𝑔)

𝑤𝑒𝑖𝑔ℎ𝑡 𝑜𝑓 𝑠𝑒𝑒𝑑 (𝑔)
 

 

 

Mechanical damages are (but not limited to): splits, cracks, partially missing hull, and partially 

missing cotyledon. 

 A deformed seed is NOT considered as damage. 

                                                           
2 Canadian Grain Commission. (2023). https://www.grainscanada.gc.ca/en/grain-quality/official-

grain-grading-guide/ Access date: Jan 03, 2024 
 

https://www.grainscanada.gc.ca/en/grain-quality/official-grain-grading-guide/
https://www.grainscanada.gc.ca/en/grain-quality/official-grain-grading-guide/
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 Seed coat or cotyledon loss with less than 20% of the surface area is NOT considered as 

damage. 

 

 

Other damage: 

Pea:  

Other damage are (but not limited to): sprouted, shrivelled, heated, and insect damaged. 

 Shrivelled: shrunken or dimpled surface. 

 Heat-damaged: dull seed coats and discoloured cotyledons from light tan to dark brown.  

 Insect-damaged: damaged by insects. 

 Sprouted: when the seed oat splits and the primary sprout emerges from between the 

cotyledons. 

 Pink peas: caused by bacteria Erwinia Rhapontici. Be able to differentiate pink pea 

(disease) and red pea (contamination). 

 Bleaching: natural sunlight damage that only applies to green peas. When 1/8 or more of 

the surface of the cotyledon is bleached to a distinct yellow colour. 

 Wrinkles: caused by rapid drying from processing during harvesting. 

 Red peas (contamination): pay attention to red/orange peas for varieties CDC 5779-1, 

CDC 5791-9, and CDC 5845-2 from 2022 

 
Figure 1e. Example of wrinkled damage, water damage, red (contamination), and pink 

(disease) peas (from left to right). 

 

 

Lentils: 

Other damage are (but not limited to): sprouted, frost damaged, heated, insect damaged, wrinkled, 

distinctly green, and disease. 

 Wrinkled: ONLY apply to red lentils. Recognize as wrinkles if the surface has a sharp 

ridge. Consider as sound for a dimpled seed coat. 

 Sprouted: when the seed oat splits and the primary sprout emerges from between the 

cotyledons. 

 Heat-damaged: appears as dark tan to black. 

 Insect-damaged: damaged by insects. 

Wrinkle Water  
Red Pink 
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 Frost-damaged: indicated by a combination of wrinkling and close adherence of the seed 

coat to the cotyledon. 

 Disease/Ergot: a purplish-black exterior, a purplish-white to off white interior, and a 

relatively smooth surface. 

 

 

Chickpeas: 

Other damage are (but not limited to): sprouted, frost damaged, heated, mouldy, un-removable dirt, 

and insect damaged. 

 Dirt: try to remove it with your fingers. Consider it as damage if the dirt is not removable 

and over 50% of the surface area. 

 Sprouted: when the seed coat splits and the primary sprout emerges from between the 

cotyledons. 

 Heat-damaged: dull seed coats and discoloured cotyledons from light tan to dark brown.  

 Frost-damaged: green or white and shriveled. 

 Green: if Kabuli type shows any green colour on the seeds or seed coats and if Desi type 

shows distinctly green colour on the cotyledons. 

 Mouldy: if they show clear evidence of mildew or mould. 

 

 

Faba beans: 

Other damage are (but not limited to): sprouted, frost damaged, heated, insect damaged, wrinkled, 

distinctly green, and disease. 

 Sprouted: when the seed oat splits and the primary sprout emerges from between the 

cotyledons. 

 Heat-damaged: appears as dark tan to black. 

 Insect-damaged: damaged by insects. 

 Frost-damaged: indicated by a combination of wrinkling and close adherence of the seed 

coat to the cotyledon. 

 Disease/Ergot: a purplish-black exterior, a purplish-white to off white interior, and a 

relatively smooth surface. 

 Blackened: when their seed coats are very dark blue to black. 

 Distinct immaturity:  

 Mould damage: if they show clear evidence of mildew or mould. 



 
2335 SCHUYLER STREET, SASKATOON, SASKATCHEWAN, S7M 5V1, TEI: (306) 933-7555, FAX: (306) 933-7208 

 

- 11 - 
 

  

Figure 2e: Damage caused by lygus bugs. 

 

Figure 3e: Sprouting of Navi faba beans from water imbibition. 
 

Figure 4e: Sprouting of DL Nevado.  

 

 

Dry beans: 

Other damage are (but not limited to): sprouted, frost damaged, heated, insect damaged, mouldy, 

rotted, and disease. 

 Heat-damaged: appears as dark tan to black. 

 Insect-damaged: damaged by insects. 

 Disease/Ergot: a plant disease producing elongated fungus bodies with a purplish-black 

exterior, a purplish-white to off white interior, and a relatively smooth surface. 
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 Mouldy: presence of dark blue exterior moulds that develop in machine-damaged crevices. 

For instance, light and dark red kidney beans may develop yellow to black interior moulds 

in the concave centre area.  

 Rotted: whole beans or pieces of beans that are visibly in advanced stages of 

decomposition and that feel spongy under pressure. 

 Discolouration: when discolouration on the seed coat covers more than half the bean or 

when the discolouration penetrates the cotyledon. 

Figure 5e. Discoloration of black bean.  
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F. Seed hardness 

 

Seed hardness is an important parameter to indicate milling yield and cooking quality. This method 

determines the hardness of pulse seeds by measuring the crushing strength of individual seeds 

using a texture analyzer (TMS-Pro, Food Technology Corporation, USA) equipped with a 2500 N 

load cell with a modified method from Karami et al. (2017) and Lovas-Kiss (2020)3. 

 

Apparatus: 

1. Texture analyzer (1 cm probe and 2500 N loading cell) 

2. Cleaning brushes 

 

Procedure: 

1. Make sure the loading cell is 2500 N and put the 1 cm probe to the loading cell. 

 

2. Turn on the texture analyzer. 

3. Click on software Texture lab Pro (name & password: admin). 

4. Click ok for program testing.  

5. In menu, click on file > load library program > seed hardness-(seed type). Click open. 

6. Click zero load to zero force. 

                                                           
3 Karami, S., Sabzalian, M. R., Rahimmalek, M., Saeidi, G., & Ghasemi, S. (2017). Interaction of 

seed coat color and seed hardness: An effective relationship which can be exploited to enhance 

resistance to the safflower fly (Acanthiophilus helianthi) in Carthamus spp. Crop Protection, 98, 

267-275. 

 

Lovas‐Kiss, Á., Vincze, O., Kleyheeg, E., Sramkó, G., Laczkó, L., Fekete, R., ... & Green, A. J. 

(2020). Seed mass, hardness, and phylogeny explain the potential for endozoochory by 

granivorous waterbirds. Ecology and Evolution, 10(3), 1413-1424. 
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7. Move the probe to the zero position (i.e., move it as close as possible to the platform with 

force remaining at 0.0 N). Click zero displacement. You should try a few times to make 

sure the zero position is correct.  

8. Move the probe to the recommended starting position (Table 1f); then click zero 

displacement again. 

9. Click on test program. Make sure the program setting is the same as Table 1f. 

10. Click on setup > preference > general. Make sure compression is chosen and 2500 N is 

set as defaulted. 

11. Place the seed right under the probe. Make sure the seed is at the center by checking from 

at least two positions.  

12. Click start and record the peak value. 

13. Report the average of 10 measurements for each sample. 

14. Save the file to: G drive>Food Crop Quality>Seed-Year>Location-Seed-Year>Texture 

Raw Data 

 

Note: 

1. The probe can be moved to higher than 10 mm for a new starting position depending on 

the seed size in step 8.  

 

 

Table 1f. Program setting for each type of seed. 

Seed type 
Starting position 

Distance in step 6 (mm) 

Break point 

Distance (mm) 
Break percentage 

(%) 

Lentil 8 1.5 30 

Pea 10 7 50 

Chickpea 10 7 25 

Faba bean 10 7 50 

Dry bean 10 6 50 
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G. Appearance of whole seed 

 

This procedure describes the steps to take a photo of each pulse seed. 

 

Apparatus: 

1. Photo taking case 

2. Petri dish 

 

Procedure: 

1. Fill up the pulse seed in the petri dish. 

2. Place the dish in the centre of the photo case and turn on the light. 

3. One representative photo for each sample is reported. 

 

Lentils 

 
Figure 1g: Red lentils of small (left), medium (middle), and large (right). 

  

 
Figure 2g: Green lentil of small (left), large (medium), and French green (right). 
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Figure 3g: Spanish brown lentils (note the speckles). 

 

 

Faba beans 

 
Figure 4g: zero tannin faba beans (left) and tannin faba beans (right). 
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Figure 5g: zero tannin faba beans: DL Nevado (left) and 1089-1-2 (right). 

 

 

Dry Beans 

Figure 6g:  Types of dry beans. 
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H. Milling of flour 

 

Milling of pulses refers to a combination of dehulling and flour milling (Thakur et al., 2019)4. 

Pulse quality attributes, such as moisture content and structure (i.e. hardness, size, and hull content), 

significantly impact the milling quality. Dehulling, which is the process of removing seed coats, 

increases the appearance, texture, palatability, and digestibility of seeds and removes 80-90% of 

anti-nutritional factors (Narasimha et al., 2003). Dehulling efficiency is an imperative parameter 

for breeders to monitor the pulse crop quality and for the pulse processors in selecting ingredients 

and developing new products. Flour milling indicates particle size reduction, so as to facilitate 

ingredient miscibility. It is critical for pulse to be milled into consistent, high-quality ingredients 

for the food industry. Milling all samples to the same level of fineness will help compare the flour 

quality and functionality. 

 

Note: 

1. Make sure a mill is cleaned properly before starting the next milling. 

2. Play attention to the temperature of the mill. Stop milling and wait for 15 min when it gets 

too hot. 

3. Make sure the milling yield is higher than 90%. 

4. Wear the N95 mask and ear muff during milling process. 

 

Calculations: 

Milling yield (%) = 
𝑤𝑒𝑖𝑔ℎ𝑡 𝑜𝑓 𝑓𝑙𝑜𝑢𝑟𝑠 (𝑔)

𝑤𝑒𝑖𝑔ℎ𝑡 𝑜𝑓 𝑠𝑒𝑒𝑑𝑠
× 100% 

  

                                                           
4 Narasimha, H. V., Ramakrishnaiah, N., & Pratape, V. M. (2003). Milling of pulses. In: Handbook 

of Post Harvest Technology. New York, USA.: Marcel Dekker, Inc. 

 

Thakur, S., Scanlon, M., Tyler, R., Milani, A., & Paliwal, J. (2019). Pulse flour characteristics 

from a wheat flour miller’s perspective: A comprehensive review. Comprehensive Reviews in 

Food Science and Food Safety, 18(3), 775-797. 
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i. Pin mill 

 

Preliminary tests show that the pin mill is a good device for pre-breaking pulses, such as faba 

beans, chickpeas, dry beans, and peas. 

 

Apparatus: 

1. Pin mill 

2. Balance 

3. Brushes 

4. Vacuum 

5. Burr grinder 

6. N95 mask 

7. Ear plug or ear muff 

 

 

 

 

 

Procedure: 

1. Weigh out 210 g seeds (without foreign matter). 

2. Close the chamber properly and plug the power. 

3. Set the gap as the largest and turn on the mill. Pour about 40 g of samples from the top and 

wait for about 30 - 45 seconds. Listen the voice to determine whether milling is finished. 

4. Unplug the power and collect all the coarse flours. 

5. Open the mill and clean it using brushes and vacuum. 

 

  



 
2335 SCHUYLER STREET, SASKATOON, SASKATCHEWAN, S7M 5V1, TEI: (306) 933-7555, FAX: (306) 933-7208 

 

- 20 - 
 

ii. Cyclone mill 

 

The Udy cyclone mill uses a high velocity air-flow, an abrasive surface, and centrifugal forces to 

grind material. The impeller rotates at a high speed creating the high velocity flow of air to propel 

articles against the abrasive surface. It is a good device to mill the pulses as a whole into fine 

powders. Milling yield of the Udy mill is 95%. The procedure describes the steps of milling using 

the cut mill. 

 

Apparatus: 

1. Udy cyclone sample mill 

2. Balance 

3. Brushes 

4. Vacuum 

5. Burr grinder 

6. N95 mask 

7. Ear plug or ear muff 

 

 

 

 

Figure 1. Udy mill screens: 0.25 mm, 0.5 mm, 1 mm, 

and 2mm (from left to right). 

 

Procedure: 

1. Weight 210 g of whole seeds or coarse flours. 

2. Verify that a screen, an impeller, and the cyclone air separator are in place. 

3. Place the Cover on the top of the Mill and secure the cover by tightening the clamps. 

4. Position a sample collection bottle under the cyclone body. 

5. Plug the power and turn on the mill. Make sure the noise is normal when the mill is on. 

6. Slowly add the samples from the top and stop adding samples when the collection bottle is 

2/3 full. 

7. Turn off the mill and unplug the power. 

8. Collect the fine powders. 

9. Open the mill and clean it using brushes and vacuum. 
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iii. Cut mill 

 

Preliminary tests show that the cut mill is a good device to mill the pulses as a whole into fine 

powders. Milling yield is about 90%. The procedure describes the steps of milling using the cut 

mill.  

 

Apparatus: 

1. Cut mill with #60 mesh sieve  

2. Balance 

3. Brushes 

4. Vacuum 

5. N95 mask 

6. Ear plug or ear muff 

 

Procedure: 

1. Weigh out 220 g seeds (without foreign matter). 

2. Switch the mill to AUTO mode. Open the milling chamber once the green light is on. 

3. Make sure the chamber is cleaned and the #60 mesh screen is used. Close the chamber. 

4. Turn on the mill. Make sure the noise is normal when the mill is on. 

5. Put the samples from the filling chamber. Only put a full hand of seeds every time, and 

wait for about 30 seconds. Listen the voice to determine whether milling is finished. Do 

not put all seeds at once; otherwise, extensive heat will be generated.   

6. Wait for one minute when the last samples are injected. It takes about 6 minutes for milling 

170 g of lentils and about 9 minutes to mill one chickpea sample. 

7. Stop the mill and collect the sample. 

8. Weigh the resulted flours and record the value. 

9. Open all chambers and clean out the remained samples using brushes and vacuum. 
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iv. Stone mill 

 

Preliminary tests show that stone mill is a good device to separate the hull and the cotyledon. The 

procedure describes the steps for dehulling and milling.  

 

Apparatus: 

1. Stone mill 

2. Balance 

3. Brushes 

4. Vacuum 

5. Powder sifter machine (#35 and 60 meshes) 

 

Procedure: 

1. Weigh out 220 g seeds (without foreign matter). 

2. Make sure the mill is cleaned before milling. 

3. Turn on the mill and make the sure it is functioning properly by listening the noise. 

4. Slowly add the samples from the top and wait till all samples are milled. 

5. Stop the mill and collect the flours. 

6. Put the samples the sifter machine and start sifting at level 6 for 15 min. 

7. Open the mill and clean out all the remained powders using brushes and vacuum. 

8. Check the samples at each screen once sifting is done. 
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I. Colour of pulse flour 

 

This procedure describes the steps to measure the absolute colour of the pulse flour (L*: white 

(100) to black (0), a*: red (+) to green (-), b*: yellow (+) to blue (-)). Values indicate the visual 

quality of the flour and the processing effect on colour. Lightness of flour increases as the fineness 

increases. 

 

Apparatus: 

1. Konica Minolta CR-400 Chroma meter 

2. Petri dish 

3. Spatula 

4. Cleaning foam brush 

 

Procedure: 

1. Connect the measuring head and data processor with the RS-232C cable. 

2. Lock the measuring head with the stand. 

3. Switch the power ON for the measuring head then data processor. Wait till DP MODE is 

displayed in the measuring head. 

4. Press the Display on the data processor till L*,a*, b* are displayed. 

 
5. White calibration: take off the protective cap from the measuring head and place the 

calibration plate vertically. Press calibration on the data processor. The screen should 

appear Y=93.5, x=0.3114, y=0.3190, or use the numeric pad to set the correct values. Press 

measure enter, and the screen will show NOW CALIBRATING. 
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6. Absolute measurement: fill up the petri dish with flours needed to be measured. Put on the 

petri dish holder, petri dish, and the lid to the measuring head. Press measure enter on the 

data processor. Three measurements are made each time, and the average is displayed on 

the screen. Always make sure there is no powder dropped into the measuring head. 

 

7. Turn off both devices when measurement is done. 

8. Put every piece back to the case. 

 

 

Data download: 

1. Connect data processor to PC with USB-Serial Converter Cable. Switch the power ON and 

press Enter to select REMOTE MODE.  

2. Click on software “CR-400 Utility” from the PC. From the window, choose Sensor head 

in Connect to frame. Click Port Setting, choose COM7 in Port and 12600 in Baudrate; 

then click OK. Click Connect to connect the PC and measuring head. 

3. Choose Excel Spreadsheet in Target to redirect data. In the Select Worksheet frame, click 

Open and choose Minolta-Sample 1. In the “Workbook List”, click Data and click Select, 

then Close. 



 
2335 SCHUYLER STREET, SASKATOON, SASKATCHEWAN, S7M 5V1, TEI: (306) 933-7555, FAX: (306) 933-7208 

 

- 25 - 
 

 
4. Click Instrument > Upload. In the “Upload Data” frame, click Upload, and all the data 

stored in the measuring head is now displayed on the excel sheet. 

 

 

Note: 

1. Clean the petri dish properly between each sample. Always make sure there is no powder 

dropped into the measuring head. 

2. The measuring head can store up to 1000 data. The device will delete data automatically 

after excessing the limit.  

3. Make sure the data are deleted in the device after uploading to the Excel sheet. 
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J. Hausner ratio 

 

Hausner ratio measures the ratio of tapped density to loose bulk density, indicating the flow-ability 

and the compressibility of the flour after milling. Hausner ratio is an important parameter in food 

products handling, packaging, storage, processing and distribution. It is useful in the specification 

of products derived from size reduction or drying processes. Usually, the lower the flow-ability a 

flour, the more compressible it becomes5. 

 

Apparatus: 

1. 25 mL graduated cylinder 

2. Spatula 

3. Funnel  

 

Procedure: 

1. Place a 25mL cylinder on a scale. Let 10.0 g of flour loosely fall in the cylinder by using a 

funnel. 

2. Record the exact volume (i.e., start volume) of the flour till 2 decimals.  

3. Lightly tap the cylinder 40 times. 

4. Increase the strength, with dropping motion, tap for 60 times then stop to check. 

5. Tap like Step 3 for 30 times more. Record the reading (i.e., end volume) to 2 decimal place. 

6. Duplicate the measure for each sample. 

                                                           
5 Buanz, A. (2021). Powder characterization. In Remington (pp. 295-305). Academic Press. 

https://doi.org/10.1016/B978-0-12-820007-0.00016-7  

Amankwah, N. Y. A., Agbenorhevi, J. K., & Rockson, M. A. (2022). Physicochemical and 

functional properties of wheat-rain tree (Samanea saman) pod composite flours. International 

Journal of Food Properties, 25(1), 1317-1327. https://doi.org/10.1080/10942912.2022.2077367 

Aulton, M. E., & Taylor, K. M. G. (2013). Powder flow (pp. 189-200). Edinburgh, Scotland: 

Churchill Livingstone (Elsevier).  

Maninder, K., Sandhu, K. S., & Singh, N. (2007). Comparative study of the functional, thermal 

and pasting properties of flours from different field pea (Pisum sativum L.) and pigeon pea 

(Cajanus cajan L.) cultivars. Food chemistry, 104(1), 259-267. 

https://doi.org/10.1016/j.foodchem.2006.11.037 

Ogunsina, B. S., Radha, C., & Govardhan Singh, R. S. (2010). Physicochemical and functional 

properties of full-fat and defatted Moringa oleifera kernel flour. International Journal of Food 

Science & Technology, 45(11), 2433–2439. https://doi.org/10.1111/j.1365-2621.2010.02423.x  

 

https://doi.org/10.1016/B978-0-12-820007-0.00016-7
https://doi.org/10.1080/10942912.2022.2077367
https://doi.org/10.1016/j.foodchem.2006.11.037
https://doi.org/10.1111/j.1365-2621.2010.02423.x


 
2335 SCHUYLER STREET, SASKATOON, SASKATCHEWAN, S7M 5V1, TEI: (306) 933-7555, FAX: (306) 933-7208 

 

- 27 - 
 

 

Calculation: 

Loose bulk density = 
𝑚 (𝑔)

𝑠𝑡𝑎𝑟𝑡 𝑣𝑜𝑙𝑢𝑚𝑒 (𝑚𝑙)
 

Tapped density = 
𝑚 (𝑔)

𝑒𝑛𝑑  𝑣𝑜𝑙𝑢𝑚𝑒 (𝑚𝑙)
 

Hausner ratio = 
𝑇𝑎𝑝𝑝𝑒𝑑 𝑑𝑒𝑛𝑠𝑖𝑡𝑦

𝑙𝑜𝑜𝑠𝑒 𝑝𝑜𝑢𝑟𝑒𝑑 𝑑𝑒𝑛𝑠𝑖𝑡𝑦
 = 

𝑠𝑡𝑎𝑟𝑡 𝑣𝑜𝑙𝑢𝑚𝑒 (𝑚𝐿)

𝑒𝑛𝑑 𝑣𝑜𝑙𝑢𝑚𝑒 (𝑚𝐿)
 

Compressibility = 
𝑇𝑎𝑝𝑝𝑒𝑑 𝑑𝑒𝑛𝑠𝑖𝑡𝑦 −𝐿𝑜𝑜𝑠𝑒 𝑏𝑢𝑙𝑘 𝑑𝑒𝑛𝑠𝑖𝑡𝑦

𝑇𝑎𝑝𝑝𝑒𝑑 𝑑𝑒𝑛𝑠𝑖𝑡𝑦 
 × 100% 

 

Note: 

1. When pouring the flour into the cylinder, use the wall of the funnel to avoid direct 

dropping into the cylinder to prevent pre-packing the flour. 

 

Table 1j. Relationship between powder flow-ability, percentage compressibility and Hausner 

ratio.  

Compressibility index 

(%) (Carr’s index) 
Type of flow Hausner ratio 

1-10 Excellent 1.00-1.11 

11-15 Good 1.12-1.18 

16-20 Fair 1.19-1.25 

21-25 Passable 1.26-1.34 

26-31 Poor 1.35-1.45 

32-37 Very poor 1.46-1.59 

>37 Very, very poor >1.59 
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K. Particle size 

 

This protocol describes the procedure to measure the average particle size and droplet size 

distribution for dry powders. 

 

Apparatus: 

1. Mastersizer 3000 with dry sample cell 

2. Spatula 

3. Cleaning brushes 

 

Procedure: 

1. Push the power switch to turn on the Mastersizer 3000, and wait for 30 min for the 

instrument to warm up. Turn on the air to 5.5 bar. Air will only be turned on for dry samples. 

2. Set up all three pieces of apparatus for loading dry flours with the order showing below. 

 

3. The gap should be set based on the flour conditions. Setting the gap to 3 is a good starting 

point for lentil, pea, faba bean, dry bean, and chickpea (black desi and desi types) flours 

(gap of 3.5 for chickpea-kabuli flours). 

4. Close the sample cell lid, and make sure it is sealed. 

5. From the PC, click on software Mastersizer 3000.  

6. Cleaning: from Menu, choose Tool > Accessories > Clean > Extensive. Click Clean to 

start cleaning. You will hear three different noises as cleaning proceeds. 

7. Go to Home > Manual measurement. In the setting, name the sample and make sure the 

setting is in default.  

8. Click Initialise instrument, make sure the highest point of Energy do not exceed 250. 

Otherwise, a second cleaning is required. Click stop when the condition is ok. 

9. Open the sample cell lid and put a full cup of samples. Close the lid. 

10. In Menu, click air flow to start the air. 

Particle size: non spherical 

Material: 

 silica flour 

 refractive index: 1.56 

 absorption index: 0.01 

 density: 1 
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11. Click feed rate and start at about 28% for lentil, pea, faba bean, dry bean, and chickpea 

(black desi and desi types) flours and 33% for chickpea-kabuli flours. Make sure the 

obscuration stays in green by changing the feed rate. 

12. Start measurement. You should monitor the obscuration all the time and change the feed 

rate if it is not in green. 

13. Five measurements are preformed for each sample. The results will show in the screen, and 

the SD for all parameters should be less than 5%. Otherwise, a repeat is needed. Click Stop 

when the measurement is finished. 

14. Select all five results and click Data quality. Make sure all the results are in good quality. 

Otherwise, a repeat is needed. 

15. Cleaning: brush out all the remained samples from the dry sample cell. In Menu, click 

Clean again (see step 1) and check initialise instrument (see step 8). 

16. Now it is ready for a new measurement. 

17. Result saving: click “save as” and name the file based on data. 

18. By the need of the day, take off the loading cell and rinse them properly. 

19. Turn off the instrument and the air control. 

 

Result upload: 

1. Open the saved file and transfer all the average value and SD to an excel sheet. 

2. For the size distribution, in “exported” frame, click export content then copy as image 

and paste the image to Word. 
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L. Ash content 

 

This method determines the ash (total mineral) content of pulse flour. The method is modified 

from AACC 08-01.016. 

 

Apparatus: 

1. Muffle Furnace 

2. Analytical balance 

3. Crucibles 

4. Desiccator 

5. Tong 

6. Heat-resistant gloves 

 

 Daily Loads: 3 

 # Samples per load: 9 

 

 

 

Procedure: 

1. Label a number at the bottom of the crucibles using pencils. 

2. Place a crucible on the balance and tare. 

3. Weigh 0.32 ± 0.02 g samples in the crucibles (0.22 ± 0.02 g for chickpea flours) and record 

the sample weight.  

4. Prepare 9 samples for the 1st load. 

5. Place all the crucibles into the desiccator. 

 

6. Place the crucibles in the muffle furnace.  

a. The crucibles CANNOT touch each other; 

b. The crucibles CANNOT touch the inside wall of the furnace. 

7. Close the door, turn on the furnace, and: 

a. Set the temperature to 560 ℃ for 15 min and turn on the fume hood. 

b. After 15 minutes, set the timer to 2 h 25 min.  

c. Turn off the fume hood after 45 minutes. 

                                             

8. Weigh samples for the 2nd and 3rd loads. Put all the samples in the desiccator. 

 

 

                                                           
6 AACC (1999). American Association of Cereal Chemists International. Approved methods of 

analysis (11th ed.). The Saint Pauls Association: Saint Paul, MN. 
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9. When the 1st load is done: 

a. Turn off the furnace. 

b. Take the 2nd load of samples out of the desiccator. 

c. Wear heat-resistant gloves and use the tong to take the 1st load of samples out of 

the furnace and place them in the desiccator.   

d. Wear heat-resistant gloves and use the tong to put 2nd load of samples in the muffle 

furnace. 

e. Close the furnace door. 

 

10. Weigh the 1st samples (and 3rd load from the previous day; see step 14) after 1 h in the 

desiccator. 

a. Use a tweezer to handle the crucible. 

b. Record the total weight (crucible + sample). 

c. Discard the ash by using a tweezer. Wipe off any remaining ash.  

d. Record the weight of the empty crucible in the crucible weight section. 

 

11. Repeat step 7, step 9, and step 10 to finish the 2nd and 3rd loads. 

 

12. Turn off the furnace at the end of Round 3. Prepare a next-day 1st load of samples and put 

them in the furnace. The remaining heat will burn off a part of the samples.  

 

13. Sample crucibles of the 3rd load will be left in the desiccator overnight. 

14. Weigh the 3rd load of samples and the next-day 1st load together on the next day. 

 

 

Calculation: 

Ash Content (%) =
𝑊𝑒𝑖𝑔ℎ𝑡 𝑜𝑓 𝑡ℎ𝑒 𝑐𝑟𝑢𝑐𝑖𝑏𝑙𝑒 +𝑠𝑎𝑚𝑝𝑙𝑒 𝑎𝑓𝑡𝑒𝑟 𝑎𝑠ℎ𝑖𝑛𝑔 (𝑔) −𝑤𝑒𝑖𝑔ℎ𝑡 𝑜𝑓 𝑐𝑟𝑢𝑐𝑖𝑏𝑙𝑒  (𝑔)

𝑤𝑒𝑖𝑔ℎ𝑡 𝑜𝑓 𝑡ℎ𝑒 𝑠𝑎𝑚𝑝𝑙𝑒 𝑏𝑒𝑓𝑜𝑟𝑒 𝑎𝑠ℎ𝑖𝑛𝑔 (𝑔)
 × 100% 

 

 

 

Note: 

1. Furnace life is reduced by repeated heating and cooling. 

2. Keep the furnace above 350 ℃ between runs. 

3. Brown coloration on the insulation material does not affect the performance/functionality 

of the furnace. 
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M. Moisture content 
 

This method determines the moisture content of pulse flour, modifying from AOAC 925.107. 

 

Apparatus: 

1. Analytical balance 

2. Convection oven 

3. Aluminum moisture pan 

4. Aluminum tray 

5. Desiccator  

6. Tweezers/ gloves 

 

Procedure: 

1. Label each moisture pan (36 pans in a run). 

2. Place all moisture pans on a tray, and place the tray on the top layer of the oven at 130 ℃ 

for 30 min. 

3. Take the tray from the oven and place the tray in the desiccator for 15 min. 

4. Weigh a moisture pan and record the weight to 4 decimals. Do not touch the moisture pans 

with your hands to avoid transferring moisture/lipid (use a tweezer or gloves). 

5. Weigh 1.2 ± 0.02 grams of samples in the moisture pan. Record the sample weight. 

6. Place the sample on a new tray. 

7. Put the tray with all samples in the oven (middle layer) at 130°C for 2 h 10 min. Do not 

put the samples on the bottom layer, as it will burn the samples. Check every 30-min to 

make sure the temperature maintains at 130 ℃. 

8. Take the samples from the oven and put them in the desiccator for 1 hour.  

9. Weigh the sample + pan. 

10. Duplicated measurements are performed for each flour. 

 

Calculation: 

Moisture content (%) = 

 
𝑚𝑜𝑖𝑡𝑢𝑟𝑒 𝑝𝑎𝑛 𝑤𝑒𝑖𝑔ℎ𝑡 (𝑔)+𝑠𝑎𝑚𝑝𝑙𝑒 𝑤𝑒𝑖𝑔ℎ𝑡 𝑏𝑒𝑓𝑜𝑟𝑒 𝑑𝑟𝑦𝑖𝑛𝑔 (𝑔)−𝑤𝑒𝑖𝑔ℎ𝑡 𝑜𝑓 𝑝𝑎𝑛+𝑠𝑎𝑚𝑝𝑙𝑒 𝑎𝑓𝑡𝑒𝑟 𝑑𝑟𝑦𝑖𝑛𝑔 (𝑔)

𝑤𝑒𝑖𝑔ℎ𝑡 𝑜𝑓 𝑠𝑎𝑚𝑝𝑙𝑒 𝑏𝑒𝑓𝑜𝑟𝑒 𝑑𝑟𝑦𝑖𝑛𝑔 (𝑔)
× 100% 

 

Notes: 

1. Make sure the desiccator is properly closed and desiccant is dry (blue = good; pink/purple 

= wet). 

2. Do not put the desiccator on the weighting bench.  

                                                           
7 AOAC. (2005). Official method of analysis (27th ed.). Virginia: Association of Oiicial Analytical 

Chemists Inc. 
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N. Protein content 

Protein content is determined through the combustion method (AOAC 990.03). Nitrogen is 

detected through a thermal conductivity detector and converted to protein content with a protein 

factor of 6.25.  

Apparatus: 

1. Protein Analyzer (Elementar, German) 

2. Analytical balance 

3. Weighing apparatus  

4. Heat resistance gloves, tong, pliers, wrench, and ladder 

 

System Preparation: 

1. Record your name and start time in the Log Book. 

2. If the instrument is off from previous day, turn on the analyzer by pressing the green 

power button on the lower right side. Open the software and wait for the connection to be 

established. Turn on the furnace through System > Furnace. Wait till the furnace 

temperature reach 950 °C and give another half an hour for stabilization. 

3. If the analyzer is on from the previous day, wake up the system from sleep mode using 

the menu System > Wake up. 

4. Turn on both gas tanks by turning a quarter (¼) of the knob directly connected to each gas 

tank. The direction of opening and closing is indicated on top of the knob.  

5. The intake pressure of the O2 is 2.5 bar, and CO2 is 1.4 bar. The pressure generally remains 

stable, and usually you don’t need to make any adjustment (or adjust it slightly). However, 

you should monitor the values throughout the day. Report to your supervisor if a large 

discrepancy occurs. 

6. When the above steps are ready, go through the standby checklist. 

a. Make sure the furnace temperatures, flows, and pressures all green. 

b. Flow delta < 15 ml/min. 

c. Pressure delta < 400- 500 mbar. (Up to 500 mbar is still okay, but the furnace tubes 

should be replaced soon).  

d. Maintenance counter bar green. 
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Sample Preparation: 

7. Everyday you should create a new file from the menu New. Save the file in G drive and 

name it with the following format: YYYYMMDD-seed type-location-protein (e.g. 

20230606-pea-Swan River-protein). Save the file multiple times during the day to ensure 

your progress is consistently saved. 

8. There are three types of runs for preparing the analyzer: blank, run-in, and daily factor. 

Samples prepared should follow the below list: 2 run in of blank, 3 blank, 2 run in of 

aspartic acid, and at least 3 aspartic acid.  

a. 2 run in of blank: the first N area is usually high, and the second value normally 

is below 150. 

b. 3 blank: all N area < 150. The three values will be used as blank value in the 

calculation. You should make sure all blanks are at the range before you proceed 

further. 

c. 2 run in of aspartic acid: for analyzer to run, not taking in the daily factor 

calculation. 

d. Aspartic acid: N factors should be between 0.900 and 1.100. The largest difference 

between any two factors should be less than 0.010 (ideally < 0.005). Or you must 

perform more aspartic acid until you have 3 N factor values with differences smaller 

than 0.01.  

e. It is recommended to put a stop tag at the end of aspartic acid. You should keep an 

eye of each O2 curve (square-shaped oxygen flow). 

f. Routine blank, run-in, and daily factor should be performed again after replacing 

part. 

Samples 

2 Run In 

3 Blank 

2 Run In 

3 Aspartic acid 



 
2335 SCHUYLER STREET, SASKATOON, SASKATCHEWAN, S7M 5V1, TEI: (306) 933-7555, FAX: (306) 933-7208 

 

- 35 - 
 

9. Always check whether the balance is level. Adjust the leveling feet until the bubble is 

exactly in the center of the level indicator. Always keep the balance clean and clean it 

immediately after a spill.  

10. Using manual pressing tool, lightly press the tin foil into bowl shape (50 x 50 mm for run-

in and aspartic acid; 35 x 35 mm for pulse flour), place the pressed tin foil onto the balance, 

close the door, and tare the balance. 

11. Add the sample to the container (0.249-0.251 g for run-in and aspartic acid; 0.1235-

0.1265g for pulse flour).  

12. Enclose the sample using the manual pressing tool.  

13. Place the enclosed sample on the balance, close the balance doors, and record the sample 

mass to the software by clicking Print. Make sure the current weight (yellow line) is correct, 

or right click the desire line and select Current weight. 

 

14. Place the sample on the carousel. Make sure you match the carousel position with the 

software (Ball valve position + 1).  

15. If you would like the measurement to start at position 1, adjust the carousel position 

through System > Carousel position. The position will be at #60 so to start at #1 (with 2 

run-in, 3 blank, actual placement begins at #5). Make sure you remove all the samples from 

the carousel before adjustment. 
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Sample Measurement: 

16. Now you are able to start you sample measurement. Click System > Single run (1) or 

System > Auto run (2). 

 
17. Always check your results, and gas flows on graphs as the measurement is running. 

a. Always check for square-shaped oxygen flow.  

b. CO2 and O2 gas flow: they should look similar to the picture below; any large 

fluctuation of these two gases can cause the analysis to be inaccurate due to 

incomplete combustion.  

c. If a block of O2 is observed, stop your measurement and report to your supervisor. 

 
 

18. Based on setting, the analysis will stop at the last sample (or sample with a stop tag) when 

you use auto run, and the system will turn to sleep mode.  

19. The system will then start depressurizing. You are able to turn off both gas tanks after that.  

20. Please DO NOT close the software or shut down the analyzer. DO NOT turn off the 

computer. 

 

Save and Export the file: 

21. Save your file at the beginning of the day and save it multiple times during measurement. 

22. Export the file and Excel sheet to G drive by the end of the day. 

a. Click File > Export/ Import > Export to export the file as SQLITE file. 

b. Click File > Export/ Import > Export sheet data (for excel) to save an Excel data 

sheet. 
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Log Book Rand Cleaning: 

23. Record information in the Log Book: time, # of sample, condition, and write down any 

maintenance preformed or situation. 

24. Clean and vacuum your work station by the end of the day. 

 

 

Shut Down Instrument: 

25. When a measurement break is longer than a week. Talk to your supervisor before 

shutting down. 

26. Shut off gas supply (step 19). 

27. Switch off the furnace in the operating software through System > Furnace. 

28. Wait 2-3 hours until the instrument has cooled down to < 55 °C. 

29. Quit the software through File > Exit. 

30. Switch off the analyser and its peripherals. 

 

 

Safety and Maintenance of Analyzer: 

1. You must perform any of the maintenance activity when there are two people around.  

2. You must use a ladder, wear heat resistance gloves, and use proper tools when performing 

maintenance activity. 

3. Report all troubleshooting activities to your supervisor and record in the Log book. 

4. Review the proper steps and video for each maintenance/troubleshooting activity from 

Elementar Academy previous to any implement.  

5. Maintenance work that requires opening gas lines should only be performed when the 

analyzer is not pressurized. 

a. To de-pressurize the analyzer for maintenance, use the menu: Options > 

Maintenance > Replace parts 

6. The current maintenance status is displayed in the lower left corner of the status view. 

a. Green: <80% of interval 

b. Orange: ≥80% of interval 

c. Red: ≥100% of interval 

7. Check the status of each event by clicking on: Options > Maintenance > Intervals 

8. It is usually not necessary to shut down the analyzer or to cool down the furnace before 

performing maintenance actions, such as: 

a. Performing a leak check 

b. Emptying or exchanging the ash crucible 

c. Exchanging combustion and drying tubes 

d. Except for removing the ball valve. This requires a cool furnace. 

9. Spare reaction or drying tubes can be filled prior to replacing parts, thus reducing the 

downtime of the analyzer.  
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Important: 

4. Furnace life is reduced by repeated heating and cooling. 

5. Keep the furnace at 950℃. Do not shut it off for weekly use.  

6. DO NOT change the furnace temperature. 

7. DO NOT change the standard method. If a new method is needed, report to your supervisor. 

8. DO NOT change the sample size. Report to your supervisor if a sample size needs to be 

adjusted. 

 

 

Maintenance Action List: 

Note that the default interval might be changed according to the actual conditions. 

 

MAINTENANCE ACTION DEFAULT INTERVAL 

Clean the nickel flap 150 samples 

Empty or exchange the ash crucible 150 samples 

Refill the eas regainer® 500 samples* 

Replace the large drying tube filling 300 samples 

Replace the small drying tube filling 1000 samples 

Replace the combustion tube filling 1000 samples 

Replace the post-combustion tube filling 2000 samples 

Replace the eas reductor® 2000 samples 

Clean the ball valve 2000 samples 

Clean the quartz bridge Inspect daily 

Clean the water condenser Inspect monthly 

Replace the combustion tube 5 fillings 

Replace the post-combustion tube 20 fillings 

Replace the ash crucible 2000 samples 

Replace the oxygen lance 2000 samples 

Replace o-rings and seals Anually 

Clean and adjust the autosampler Anually 

Clean analyzer and check for worn-out parts Anually 

Recalibrate the TCD Anually or less 
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3. INSTRUMENT MAINTENANCE 
 

This section describes the instrument maintenance, safety instruction, and other important notes to 

each instrument. 

 

A. Balance 

 

Capacity: 

The analytical balance and the top loading balance have the maximum capacity of 120g and 5000g, 

respectively. Do not weight anything that passes the limit. 

 

Transporting: 

1. Always proceed focused and with care. 

2. Hold the balance with both hands. Do not lift it by the glass draft shield. 

3. The balance should be placed to avoid vibrations and temperature fluctuations. Do not 

place the balance and the powder sifter machine at the same bench. Do not place the 

balance near the muffle furnace or oven. 

 

Leveling: 

1. Before using the balance (both analytical and top loading balances), make sure the air 

bubble is within the circle of the level indicator. If not, use the level feet on both sides to 

adjust the indicator position. 

 

Cleaning: 

1. Improper cleaning can damage the load cell or other essential parts. Do not use any cleaning 

agents. Do not spray or pour any liquids to the balance. 

2. Use a moistened lint-free cloth or a tissue. 

3. Remove any dirt or dust around the balance. 

4. Brush out any dust or samples dropped in the balance after every use. 

5. Check the level status after cleaning 

 

Calibration: 

1. The analytical balance comes with internal calibration. 

2. Weigh an item with known weight daily is recommended. 
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B. Muffle furnace 

 

Capacity: 

1. The maximum temperature for the furnace is 1100°C. Do not run the furnace above 1000°C. 

 

Cleaning: 

Daily: 

1. Remove any dust in the chamber before any use. 

2. Keep the furnace clean before and after use. 

 

Monthly: 

3. Run the empty furnace at 850 ℃ for 8 hours to burn off any contamination on the insulation 

and elements. 

 

Important: 

1. Furnace life is reduced by repeated heating and cooling. 

2. Keep the furnace above 350 ℃ between runs. 

3. Brown coloration on the insulation material does not affect the performance/functionality 

of the furnace. 

 

Thermocouple: 

1. Replacing the thermocouple periodically (once every six months) to ensure temperature 

accuracy is recommended. 
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C. Colourimeter 

 

Operation environment: 

1. Do not use the instrument near source of heat, flammable gas, dust, or magnetic field. 

2. Use the instrument at ambient temperature between 0 and 40°C. 

3. Do not subject the instrument to strong impact or vibration. Always attach the protective 

cap when not in use. 

4. Always lock the measuring head in the stand while in use. 

 

Storage: 

1. Always put the instrument back to the case while not in use. 

 

Cleaning: 

1. Always keep the instrument clean. 

2. Wipe off any dust with a soft, clean dry cloth. 

3. Do not use any solvents for cleaning. 

4. White calibration plate can be cleaned by a soft, clean dry cloth. Use lens cleaner and dru 

with cloth when the dirt is difficult to remove. 

 

Calibration: 

1. Calibrate the instrument prior to every use with the white calibration plate. 

2. Do not allow calibration plate to get scratched or stained. 
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D. Protein analyzer 

 

Safety: 

1. You must perform any of the maintenance activity when there are two people around.  

2. You must use a ladder, wear heat resistance gloves, and use proper tools when performing 

maintenance activity. 

 

Maintenance of Analyzer: 

1. Report all troubleshooting activities to your supervisor and record in the Log book. 

2. Review the proper steps and video for each maintenance/troubleshooting activity from 

Elementar Academy previous to any implement.  

3. Maintenance work that requires opening gas lines should only be performed when the 

analyzer is not pressurized. 

a. To de-pressurize the analyzer for maintenance, use the menu: Options > 

Maintenance > Replace parts 

4. The current maintenance status is displayed in the lower left corner of the status view. 

a. Green: <80% of interval 

b. Orange: ≥80% of interval 

c. Red: ≥100% of interval 

5. Check the status of each event by clicking on the bar or using the menu: Options > 

Maintenance > Intervals 

6. It is usually not necessary to shut down the analyzer or to cool down the furnace before 

performing maintenance actions, such as: 

a. Performing a leak check 

b. Emptying or exchanging the ash crucible 

c. Exchanging combustion and drying tubes 

d. Except for removing the ball valve. This requires a cool furnace. 

7. Spare reaction or drying tubes can be filled prior to replacing parts, thus reducing the 

downtime of the analyzer. 

 

Important: 

1. Furnace life is reduced by repeated heating and cooling. 

2. Keep the furnace at 950℃. Do not shut it off for weekly use.  

3. DO NOT change the furnace temperature. 

4. DO NOT change the standard method. If a new method is needed, report to your supervisor. 

5. DO NOT change the sample size. Report to your supervisor if a sample size needs to be 

adjusted. 


